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Introduction

Thiswhite paper provides business and technical overviews of the integration between the IBM Rational Cles
products and |BM ® WebSphere® Studio Application Developer (Application Developer). It coversthe benefits
of the Rational ClearCase product family, the software configuration management functions available within
IBM WebSphere Studio Application Developer, and the use of the Rational ClearCaseproduct with WebSphere
Studio Application Developer. Technologistswill aso benefit from installation information and usage scenarios.

IBM Rational ClearCase and IBM WebSphere Application Developer
Integration Overview

IBM has recently introduced IBM WebSphere Studio Application Developer, the next -generation
e-business devel opment environment. It helps multi-functional development teams speed the deployment of
complex e-business applications that encompass code, content, and components such as XML, HTML, Java™
servlets, graphics and more. IBM Rational ClearCase isthe market-leading software configuration
management sol ution that scales from small workgroups to large enterprise devel opment organi zations.
Whatever your software configuration management needs, there is a Rational ClearCase solution that can help
you improve predictability and accuracy.

IBM Rational ClearCase has been integrated with IBM WebSphere Studio Application Developer.
Much more than a high-level facility for checkin and checkout, this deep integration enablesawide
array of Rational ClearCase software configuration management operations to be performed right from within
the Application Developer environment. Benefits of this powerful integrated environment include the ability to:
- Speed development
Quickly get up and running with the market-leading software configuration management solution
Ensure software accuracy and team effectiveness
Reduce deployment risk
Lower training costs through a single familiar environment

For your convenience, the entry-level Rational ClearCase LT version 4.2 product isincluded in the IBM
WebSphere Studio Application Developer (Application Devel oper) product packaging. The Rational ClearCase
product for medium- and large-scal e enterprise application development is not included on the A pplication
Developer CD. However, it works equally as well with the Rational ClearCase— Application Developer
integration software. New and existing Rational ClearCase customers can take advantage of the same strong
integration to ensure devel opment accuracy.

IBM Rational ClearCase Integration with IBM Visual Age for Java—Integration also existsbetween IBM Visud Age®
for Javaintegrated development environment and Rational ClearCase. This allowsyou to use the same market-
leading software configuration management system—Rational ClearCase—across a development environment

that encompasses both IBM VisualAge for Javaand WebSphere Studio Application Developer. Thiswhite paper
discusses the migration process for those customers who are presently using VisualAgefor Javawith Rationd
ClearCase and who wish to migrate IBM WebSphere Studio Application Developer with Rational ClearCase.



Rational ClearCase Integration With IBM WebSphere Studio Application Devel oper

IBM Rational ClearCase: Market-Leading Software Configuration Management

Rational ClearCase isthe market-leading software configuration management solution that simplifiesthe process
of change. Rational ClearCase provides afamily of products that scale from small project workgroupsto the
distributed global enterprise. It helps software teams control everything that evolves in softwaredeve opment—
requirements, design models, source code, change requests, test scripts, and more.

Rational ClearCase products offer tools and processes that you can implement today and tailor as you grow
without changing configuration management systems—no retraining, retooling or migrating data. By automating
many necessary, yet error-prone tasks, the Rational ClearCase product family enablesteamsto build the highest
quality software in Internet time. On asingle project, you must choose to use either Rational ClearCase LT or
Rational ClearCase as the software configuration management solution.

About IBM Rational ClearCaseLT

Rational ClearCase LT isthe entry-level, scalable software configuration management solution that is

ideally suited to small teams and small project workgroups who develop applicationslocally on asingle server.
Rational ClearCase LT, Microsoft® Windows® version, is conveniently included in IBM WebSphere Studio
Application Developer packaging to provide easy access to software configuration management functions.
Rational ClearCase LT for UNIX offers the same functionality and runs on the IBM AIX® and other UNIX®
operating systems.

Easy to install and manage, Rational ClearCase LT provides:

Powerful version control capabilities—including the ability to version any digital artifact produced across
the software development lifecycle, as well as directories that may evolve as the project progresses. It
maintains compl ete, annotated histories of source code, binaries, executables, documentation, test suites,
libraries and Web elements. Rational ClearCase LT employs afile locking model, where write accessto
filesin the shared Versioned Object Base (VOB) is provided only when files have been checked out. A
Versioned Object Base or VOB is the term used to describe the ClearCase configuration control storage
repository.

Snapshot views—provide easy, transparent access to the right versions of files and directoriesrequired to
compl ete a specific task, while shielding team members from potentially destabilizing changes being made
by other developers.

Deep integration with IBM WebSphere Studio Application Devel oper—permitsusersto efficiently perform
most Rational ClearCase functions right from within the Application Devel oper user interface.

Parallel development support—to dramatically accelerate development, Rational ClearCase LT supports
parallel development activities. Featuresinclude automatic branching to enable multiple devel opment teams
to work independently from the same code base, and patented diff/merge technology that efficiently merges
source code, HTML and XML files.

Web interface for remote online access—providesuniversa dataaccessfrom standard Web browsers. From
the browser, users can accessviews comprised of the “public” VOB and private work areas.

Tight integration with IBM Rational Clear Quest— Rational ClearQuest® isthe change and defect tracking
solution that supports multiple levels of integration with Rational ClearCase. Rational ClearQuest canbe
used to relate change requests to a code base stored in Rational ClearCase LT, and can provide prioritized
“to do” lists. Through Unified Change Management, you can also take advantage of a more structured
integration and workflow between these tools.

Unified Change Management (UCM)—UCM is an optional out-of-the-box activity-based process for
managing change. UCM can be selectively used on a project-by-project basis. Through Retional ClearCase
and Rational ClearQuest, UCM helps managers prioritize and orchestrate the many development activities
that must be performed on hundreds of different artifact versions. With UCM, team members know what
activities must be performed on which artifacts. UCM hel ps teams effectively “baseline” requirements
together with code, models, test assets and more.
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Easy installation to jumpstart devel opment— Rational ClearCase LT is an easy-to-install solution for a
single-server architecture. Intuitive start-up wizards automate server set up, while built-in TCP/IP
networking simplifies administration in amixed (UNIX and Windows) environment.

Strong scalability and seaml ess upgrade path—as your team’ s needs change and grow, you may require
enterprise-level software configuration management capabilities, such as advanced build management, data
replication and multiple distributed servers. Y ou can easily upgrade to Rational ClearCase while you
preserve established VOBs and views. Rational ClearCase seamlessly meets your evolving devel opment
needs without re-training, re-tooling or changing processes.

Integrated with IBM Rational Suite lifecycle development solution— Rational ClearCase LT isincluded in
Rational Suite®, the end-to-end integrated lifecycle development solution. As part of the powerful

Rational Suite Team Unifying Platform, it enables development teams to improve devel opment speed and
software quality.

About |BM Rational ClearCase

Rational ClearCase is the market-leading software configuration management solution that supports medium and
large-sized development teams on awider variety of platforms. Y ou can easily upgrade to the comprehensive
Rational ClearCase solution from Rational ClearCase LT as your team grows and your development projects
become more complex. If your development teams perform enterprise-level software development, Rational
ClearCase provides all of the functionsincluded in Rational ClearCase LT plus:

Advanced build management—enables you to streamline the build process while ensuring reproducibility
and improving accuracy. The enterprise-level build management capabilitiesin Rational ClearCase
optimize build times, guarantee the reproducibility of software versions, and audit builds. The Rational
ClearCase clear make and omake functions ensure accuracy during the build process by automatically
detecting dependencies, reusing derived objects, and producing detailed build documentation. Rational
ClearCase is compatible with internally-devel oped build programs and Windows/UNIX make programs,
enabling existing applications to be placed under Rational ClearCase control.

Distributed Devel opment Support—enterprise development organizations can be comprised of
geographically distributed teams creating complex applicationsin a parallel development environment on
multiple distributed servers. Through the IBM Rational ClearCase MultiSite optional add-on, distributed
organizations can effectively collaborate through locally -available, automatically-replicated V OBs.

Dynamic and snapshot views—Two different types of views provide flexible workspace management.
Available only in Rational ClearCase, dynamic views provide global, transparent access to any version of
any element and areideal for an audited build environment or acomplex project that requires instantaneous
updates to evolving sourcefiles. Ideally suited to disconnected users and early -stage projectsthat require
isolation, snapshot views provide easy access to the right versions of artifacts.

Process configurability—enables you to transparently enforce configuration management policiesacrossa
project without dictating specific procedures that everyone must follow. Rational ClearCase provides
customizable event triggers, object locks, granular access control, automatic branch creation and automatic
e-mail notification that can all be used to guide development processes.

Deployment integration with IBM WebSphere Application Server—Availableonly for WebSphere servers,
the Deployment Wizard for IBM WebSphere automates the deployment of filesfrom IBM WebSphere
Studio to IBM VisualAge for Javatest environments, saving time and producing a deployment audit trail
that isreproducible. The Deployment Wizard also automates transfer of IBM WebSphere Studio and IBM
VisualAgefor Java artifacts to a staging or production repository, providing a secure and reliable way of
archiving and restoring an existing WebSphere application. Thisintegration supports WebSphere
Application Server, Visual Age for Java, and WebSphere Studio 3.5 and later.

IBM Mainframe Devel opment Support—Rational ClearCasefor the IBM Mainframe supports both the IBM
S§/390° and IBM zSeries™ platforms running the SUSE Linux operating system. Rational ClearCasefor the
IBM Mainframe enables devel opment organizations to achieve “ economies of scale” by centralizing the
administration, management and storage of development assetson asingle powerful platform. The Rationa
ClearCase comprehensive platform coverage al so offers organizations the ability to share artifacts between
users working across the Windows, UNIX and Linux environments.
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Upgrading from Rational ClearCaseLT to Rational ClearCase
Asyour needs and your organization grow, the Rational ClearCase product family isuniquein itsability to grow
with you. When you have Rational ClearCase LT, it's easy to upgrade to Rational ClearCase without retraining,
retooling or migrating data. Rational ClearCase isanideal solution when your needsinclude:

Large or distributed project teams

Reproducibility and auditability of software build versions

I nstantaneous updates to project elements

Multiple development servers

Transparent enforcement of configuration management policies

Development environment support on the IBM zSeries mainframe platform

Automated deployment options for IBM WebSphere and the Visual Age for Javatest environment

To upgrade to Rational ClearCase, contact IBM Rational using one of the contact options listed below.

The IBM WebSphere Studio Product Family

Initially e-business applications were HTM L-based presentations of information. No longer. Today’s
applications are more complex, leveraging HTML pages, XML components, awide array of Java applets,
servlets and EJB™ components, and more. Development tools that are vertically focused on either Web site
devel opment or Java application development are inadequate for rapidly integrating and maintaining complex
applications. Asthe next-generation IBM development environment, IBM has introduced WebSphere Studio
Site Developer and WebSphere Studio Application Developer to meet avariety of development needs.
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Figurel: Thenew IBM WebSphere Studio product family

WebSphere Studio Workbench—WebSphere Studio Site Developer and WebSphere Studio Application
Developer are built on WebSphere Studio Workbench, anew IBM development tools platform that isthe
foundation for next -generation IBM development tools. Thistechnology allowsIBM and other tool vendorsto
participate in an open, simple, extensible, team-enabled, and portable devel opment environment by creating
“plug-ins’. WebSphere Studio Workbench is not a purchasable IBM product, but rather atechnology that is
seamlessly availablein “plug-in” products. Optimized for the WebSphere software platform, it providesthe base
for accessing common services.

WebSphere Studio Application Devel oper—BYy focusing on J2EE™ server—side (EJB and serviet) devel opment,
deployment and profiling, this new product hel ps solve the most demanding e-businessapplication development
challenges. Itisasingletool for developing and managing HTML, JSPs, Java, servlets, rich media, XML, and
Web services. It also provides:

A J2EE-complaint environment for developing, testing and deploying EJB components

Relational database tools for creating and manipulating relational database schemas
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Performance analysis tools that enable you to view and analyze logs as the application runs
IBM WebSphere Studio Site Devel oper—a subset of Application Developer, thisis an easy to use tool for
devel oping and managing Web sites that include HTML, JSPs, Java, servlets, rich media, XML, and Web
services. Bringing all aspects of application development into acommon interface, it lets diverse Web
application development teams access all of the information they need.

IBM WebSphere Studio Professional and WebSphere Studio Advanced version 3.5 and above—areprecursor
products to WebSphere Studio Site Developer.

IBM Visual Age for Java—is IBM’sintegrated devel opment environment for Java application development.
WebSphere Studio Application Developer is the follow-on tool set that addresses extended e-business
development needs. Included in the packaging for Application Developer during 2001 and 2002, VisualAge for
Java can be used with Application Developer to complete projects that require development in both tools. Over
time, functionality in VisualAge for Javawill be migrated to Application Developer.

Getting Started: The Rational ClearCase Integration with WebSphere

Studio Application Developer

This section discusses the integration architecture between Rational ClearCase and WebSphere Studio
Application Developer. It explainsthe installation process and includes a“ guided tour” of the integrated
environment workspace. Unless otherwise noted, Rational ClearCaseis used in this and remaining sections of
this document is discuss Rational ClearCase and Rational ClearCase LT capabilities.

I ntegration Architecture

Asillustrated in Figure 2, IBM WebSphere Studio Application Developer is aplug-in for the IBM WebSphere
Studio Workbench. The Rational ClearCase integration software, which works equally well with Rational
ClearCase and Rational ClearCase LT versions 4.2 and later, is aso a plug-in to WebSphere Studio Workbench.
When other tools are plugged into the architecture, Rational ClearCase operations can be performed on other
elements produced by these other tools.

Rational ClearCase
or
Rational ClearCase LT

Integration WebSphere Studio
Software Application Developer

IBM WebSphere Studio Workbench

Figure 2: Rational Clear Case— I|BM WebSphere Studio Application Developer integration ar chitecture.

Installing Rational ClearCasein the I ntegrated WebSphere Studio Application Developer Environment

The Application Devel oper product CD includesthe Rational ClearCase integration software component as well
asthe Rational ClearCase LT product. Theinstallation process for thisintegrated environment has been
designed to flexibly meet the needs of several different customer use scenarios.

During the Application Devel oper installation, you are prompted to choose the software configuration
management system that you will use within Application Developer. Y ou must select between Version Change
Manager (VCM), Rational ClearCase LT or another configuration management sol ution which you specify. You
cannot run two different configuration management systems concurrently within the Application Developer
environment, so it is recommended that you choose options carefully at this key decision point.

If you choose Rational ClearCase LT, the WebSphere Studio Application Developer - Rational Clear Case
integration plug-in component is automatically installed during the Application Developer installation process.
This process does not install the Rational ClearCase LT product. Thefinal screen of the installation wizard
remindsyou toinstall Rational ClearCase or Rational ClearCase LT if you do not already haveit installed and
provides the location of the Rational ClearCase LT product on the CD. If you are planning to use Rational
ClearCasein this environment and do not already haveit installed, you must purchase and install it.
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After installation, you can determine which software configuration management solution is enabled in
Application Developer. To do this, go to the command prompt and enter the path where the Rational ClearCase
pluginisinstalled. Thedefaultis. program files\IBM\application devel oper\plugins\com.rational .clearcase.
Execute the cm_statuscommand and you will see alist of those Rational ClearCase plug-in elementsthat are
enabled. If you need to enable the Rational ClearCase plug-in or help file execute the enable_clearcase
command.

Setting Rational ClearCase Preferences

You can change Rational ClearCase preferences and configuration options within the Application Devel oper
user interface to suit your development needs. To access Rational ClearCase preferences, select Window >
Preferences from the Application Developer pull-down menu. The Preferences dialog box appears, which
enables you to configure both Application Developer and Rational ClearCase functions. Click on Rational
ClearCase preferences to set configuration options.
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Figure 3: IBM WebSphere Studio Application Developer and Rational Clear Caseintegrated Preferences
dialog box.

Connecting to Rational ClearCasein the Application Developer Environment

Rational ClearCase alowsyou to work both online and offline. 'Y ou must connect to Rational ClearCase within
Application Devel oper workspace before you can begin using those Rational ClearCase functionsthat require
accessto Rational ClearCase servers. Examplesinclude delivering completed code and rebasing your change set
before performing specific activities. Click the Connect to Rational Clear Case button ontheRationa ClearCase
toolbar before you perform functionsthat require accessto Rational ClearCase servers. Any Rational ClearCase
views that are open in the Application Devel oper Navigator window are refreshed as a background operation so
that you can continue working while the refresh occurs.

I ntegrated Rational ClearCase and WebSphere Studio Application Developer Environment Overview

This section provides a“guided tour” of theintegrated user interface. Theintegrated user interfaceincorporates
common functions provided by WebSphere Studio Workbench, aswell as Application Developer and Rational
ClearCase functions. For the most part, you will notice that it is an easy-to-use, streamlined environment. You
cannot discern whether afunction is derived from the WebSphere Studio Workbench or from Application
Developer. You will also notice that Rational ClearCase functions are easy to access, yet are discernable.
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The term workspace has different meaningsin Application Developer and in Rational ClearCase. In Application
Developer, aworkspace as the set of projects auser can work on in that instance of Application Developer. In
Rational ClearCase aworkspace generally means a Rational ClearCase view. A view provides controlled,
versioned accessto the exact set of files or file versionsin the VOB. Rational ClearCase views simplify the
work environment by providing the elements necessary to complete particul ar tasks while shielding the
complexity of the larger development environment. Remember that in Rational ClearCase LT, you can create
snapshot views, while in Rational ClearCase you can create both snapshot and dynamic views. An Application
Developer workspace may not necessarily incorporate everything found in a Rational ClearCase view, for
example, it may include a project folder that is not under Rational ClearCase control. For purposes of clarity in
thiswhite paper, the term “ Application Devel oper workspace” is used and a Rational ClearCase view or
workspaceissimply caled a“view”.

SeeFigure 4. Thelabelsindicate different work areas and functionsin the integrated environment.
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Figure4: Screen shot illustrating the integrated WebSphere Studio Application Developer — Rational
Clear Case environment. All functionsaretightly integrated in a single environment to provide ease of use

and development speed.

Connect to Rational Clear Case— Rational ClearCaseis off-linein Application Developer until you click on
the Connect to Rational ClearCase button. This connects you to Rational ClearCase server(s).

Rational ClearCase Pull-down Menu—enables you to perform specific Rational ClearCase operations right
from within the Application Developer workspace. When you are using Rationa ClearCaseL T, someitems
on this menu will be grayed out because these options are only available in the Rational ClearCase product.
To enable these operations, upgrade to Rational ClearCase. For alist of operationsthat are available on this
pull-down menu, refer to the table below.

Application Developer and Rational ClearCase Toolbar—Thistoolbar (or corresponding pul l-doan menu)
isused to perform Application Developer and Rational ClearCase functions. Y ou can quickly and easily
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perform Rational ClearCase operations and UCM functions through a simple mouse click right from within
the Application Devel oper workspace. Source control operations are also available on common project files
through the right mouse button and ClearCase context menu, and the ClearCase pull-down menu.

Application Developer Package, Hierarchy and Navigator Window with Integrated Rational ClearCase
View—An Application Developer function, the Navigator window provides shared accessto common files.
Y ou see Rational ClearCase integration in this area through a view that provides controlled, versioned
access to common projects stored within Rational ClearCase VOBs. Next to the directories and filesin this
window, you seeiconsthat illustrate various Rational ClearCase version control states such as checked out,
checkedin, etc. Y ou will notice that there are two projectsin the window. One of them isunder the control
of Rational ClearCase and the other isnot. The Package, Hierarchy and Navigator windows show different
aspects of project elements. This White Paper refers to the Navigator Window that istypically used by
development team members to access project files.

Application Developer Coding Environment—Inthe center isthe WebSphere Studio Application Developer
coding environment, where devel opment tasks such as Java and EJB coding can be performed.

Application Developer Outliner—provides access to the classes and methods that relate to the selected
project and/or components.

Application Developer Console—showstasks related to the project. Rational ClearCase error messages do
not appear here.

Rational Clear Case Console—some Rational ClearCase error messages appear in this console window.
Other Rational ClearCase error messages may appear in a separate pop-up dialog box, depending upon the
operation in question and the error message.

Rational ClearCase Functionsin the Application Developer Environment

From within the Application Developer environment, you can perform many Rational ClearCase functions. As
we have just seen, these options are accessed in one or more ways: through the Rational ClearCase pull-down
menu; by selecting afile, right-clicking, and selecting the ClearCase option from the context menu; or by
clicking onicons on the ClearCase toolbar. Thefollowing tableisan overview of Rational ClearCase functions
that can be performed from within the Application Developer user interface. Thiswhite paper does not cover
every function, however, you can refer to the Rational ClearCase online help within the Application Devel oper
user interface for more information.

Rational ClearCase Rational ClearCase Rational ClearCase
Context Menu Options Menu Options ToolBar Icons
Move Project into ClearCase Connect to Rational ClearCase Connect to Rational ClearCase
Add to Source Control Add Project to Workspace Add to Source Control
Check Out Set Current Activity Check Out
Check In Deliver Stream Check In
Undo Check Out Rebase Stream Undo Check Out
Get Latest Version Update View Set Current Activity
Refresh Status ClearCase Build (Rational ClearCase | Deliver Stream
Hijack only) Rebase Stream
Compare With Previous Version Run ClearCase Explorer Refresh Status
Show Project Checkouts Get Latest Version
Show Version Tree Run Merge Manager Compare With Previous Version
Show Properties Create New View Show Version Tree
Show History Edit View Properties Show Properties
Start/Stop View Update View
Mount/Unmount VOB ClearCase Build
ClearCase Help Run ClearCase Explorer
ClearCase Help
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Figure5: Rational Clear Case Explorer.

The Rational ClearCase Explorer

The Rational ClearCase Explorer isagraphical user interface that is separate from the Application Devel oper
Navigator. It letsyou manage and view software assets under Rational ClearCase control. Thisgraphical user
interface provides accessto Rational ClearCase functions such as creating views, accessing metadata, accessing
the reporting wizard and more. In Application Developer, you can conveniently access the Rational ClearCase
Explorer from the ClearCase pull-down menu or through the ClearCase tool bar.

Creating Projects and Views in the Integrated Environment

Y ou can create or join projects and create one or more views of the VOB with Rational ClearCase. This section
discusses the process of establishing projects and views under different scenarios.

Creating a New Application Developer Project Under Rational Clear Case Control

To create anew version-controlled project, use the File>New>Project option on the Application Developer
toolbar or menu. A New Project dialog box appears where you specify aproject name. Y ou must change
the location of the project to aVV OB location by unchecking the Use Default Location element and selecting
apath in aRational ClearCaseview. Through aview, you are selecting adirectory within aVOB to store
project files. The Add Elementsto Source Control dialog box appears. Y ou choose those elements that
you wish to add to source control in the specified VOB. Next you see that the project files you have placed
under source control appear in the Navigator with version control statusicons next to them. See Figure 6.
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Figure 6: WebSphere Studio Application Developer projectsunder Rational Clear Case source
control.

Controlling an Existing Application Developer Project with Rational ClearCase

An existing project that has aready been worked on in the Application Devel oper workspace can be placed under
the control of Rational ClearCase. Thisisdone by selecting and right clicking on the project and selecting
ClearCase > Move Project to Clear Case option from the context menu. Y ou are then prompted to enter the
directory path to the Rational ClearCase VOB. Usethisoption if you are moving a WebSphere Studio project
into a Rational ClearCase VOB. Donot use the Move option within Application Developer for this purpose.
Rational ClearCase source control icons appear next to the project directories and filesin the Navigator. See
Figure6.

Adding an Existing Application Developer Project Under Rational Clear Case Control to the Application
Developer Workspace

Existing Application Devel oper projects may be stored in aV OB but may not bein the Application Devel oper
workspace. Thisistypically the case when auser first installs Application Developer, begins working on a
multi-person project, or beginswork on anew version of aproject. These projects can remain under the control
of Rational ClearCase and be added to the newly installed Application Developer workspace. To do this, select
ClearCase > Add Project to Wor kspace from the pull-down menu in Application Developer. The Rational
ClearCase Add Project dialog box appears, where you specify the directory location for the existing project in the
Rational ClearCase VOB. Itisimportant to enter the directory location that isthe root directory of the project.
The project should now appear in the Application Developer Navigator window.

Migrating Existing VisualAge for Java and Other Projects Already Under Rational ClearCase Control to
Application Devel oper

Existing projects that were developed with IBM VisualAge for Javaor other tools and that are already under the
control of Rational ClearCase can be added to Application Developer. Thisprocessissimilar to creating anew
project, however you must ensure that project characteristics are carefully set in the New Project didog box to
match those of your existing project.

To do this, use the File>New>Project option on the Application Developer toolbar or menu. A New Project
wizard appears. Y ou must specify the same project name and project type, and ensure that other characteristics
of your project match the existing project. Uncheck the Use Default Location box and select thedirectory ina
Rational ClearCase view in which the project resides. The project directories and files appear in the Navigator
and Package windows with Rational ClearCase source control icons next to them. See Figure 6.

Especially for EJB applications, refer to the IBM documentation for additional information and condderationson
migrating projects that were created in VisualAge for Java or other toolsinto Application Developer.
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Automated Migration of VisualAge for Java Projects Under Envy Source Control to Application Developer
with Rational ClearCase

If you usethe Visual Agefor Java Envy source code repository to store projects and artifacts, you can chooseto
automatically migrate to Rational ClearCasein Application Developer by using a Rational partner product called
CodeProa Migrator for Rationala ClearCasea . Instantiations, an advanced IBM Business Partner,

provides this automated code repository migration tool. Now you can easily migrate existing

applications that are under Envy source control to Application Devel oper with Rational ClearCase.

CodePro Migrator for Rational ClearCase converts and migrates:

Source code

Resources

Structures

Traceability attributes— ownership, timestamps and derivation history

to Rational ClearCasein Application Developer. Solutions, projects, and packages are fully converted to
ClearCase structures.

Prior to performing the migration you perform initial analysisto identify target VisualAge for Java assets
and determine how the components are related. CodePro Migrator provides dependency information to aid
in your analysis. CodePro Migrator supports several approaches to performing the migration:

Map Visual Age for Java Projectsto Application Developer Projects with Rational ClearCase - You
can analyze your Visual Age for Java projects and determine if the projects represent individual
programs or subsystems of alarger program. Individual programs map into separate Application
Developer projects, and also into separate view directories. Depending on build dependencies,
complex programs map into either a series of Application Developer projects, one for each subsystem,
or asingle Application Developer project. If subsystems are mapped to Application Devel oper
projects, they must be constructed with appropriate dependencies. Complex programs depending on
other Application Developer projects require a separate directory for each project.

Migration of Current and Historical Versions of Projectsto Rational ClearCase - Y ou select your
solutions, projects, or packages to migrate, and aview directory that will contain the migrated code
and artifacts. You can create views and VOBs using Rational ClearCase wizards, or select an existing
view. Filtering mechanisms aid in the selection of alimited set of versions. The mapping of itemsto
Rational ClearCaseis collected into an export set. The export set and the mapping parameters are
stored persistently in Visual Age for Java Envy source control. The export-import is performed
according to the export set, and successful migrations are recorded.

Update Rational ClearCase Based on New Development Donein IBM Visual Age for Java - Y ou can
update your Rational ClearCase VOB by re-invoking the migration of an export set. New items and
new versions of existing items can be migrated to Rational ClearCase. Older versions can be added as
branches in the derivation tree. In the case of amigration conflict, in which you may have selected a
version number that already existsin Rational ClearCase, you can re-map the version number and run
the migration again.

Re-target the Migration - If you decide to re-target your export set to adifferent view directory, the
portions of the export set that support update tracking can be flushed so migration and update can be
tracked in the new directory.

There are some special considerations for exporting EJB-based applications from the Visual Age for Java
environment into the Application Devel oper environment. For more information, refer to IBM WebSphere
Studio Application Developer readme file and look for section 5.0 on migration which provides sources of
more information. For more information on I nstantiations CodePro Migrator for Rational ClearCase,
please visit www.instantiations.com/codepro/migrator
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Creating a New View

A Rational ClearCase view provides access to the exact versions of files required to complete particular tasks
while shielding complexity. Views can be created directly from within the integrated A pplication Devel oper
environment. To create anew view, use the Clear Case>Create New View menu option. Y ou are presented with
aView Creation Wizard where you are prompted for various options of your view, including UCM and
development stream options. Note that creating aview does not make new elementsvisiblein the Application
Developer user interface. Y ou have to create or import projects from aVV OB (through the view) into the
Application Developer workspace before any elements become visible in Application Devel oper.

Sourcefiles are generally versioned and shared with other project team members, while build files are typically
private and not shared. Users must ensure that the right files are versioned, i.e., auser may not want to version
and share build files and build settings, but may wish to version and share sourcefiles.

Creating Multiple Project Views

Often, devel opers work with multiple views of the same project, and these views must be accessible from the
Application Developer workspace. It is strongly recommended that you associate one Rational ClearCase view
with aunique Application Developer workspace. For example, if you want to work in aparallel development
environment where you have a development branch for bug fixes for release A and new devel opment for release
B, you would have two different Application Developer workspaces, onefor View A and onefor View B.

After anew view is created, you must associate aworkspace with it. From the command line or within Windows
Explorer, create anew workspace storage directory. It ishelpful to use the same name as the corresponding
Rational ClearCaseview. When you start Application Developer from the command line, use the —dataflag and
the storage directory path or create a shortcut with the —data flag and path. When you cregte or import aproject
into the Application Devel oper workspace, you must ensure that you use the correct view when specifying the
project location. Refer to the online help for moreinformation.

Updating Viewsin the I ntegrated Environment

Rational ClearCasein the Application Devel oper workspace can be used to bring different versions of filesinto a
project and to synchronize thefilesin the Application Developer workspace with the Rational ClearCase VOB.
The Update View function in Rational ClearCase updates the user’ s snapshot view. It finds and automatically
refreshes checkout status information, new files and versionsin the project’s VOB, and files that have been
edited while in disconnected mode. This change is not automatically reflected in the Navigator window, so a
manual refresh of the project isrequired. This can be accomplished using the Application Developer Refresh
From Local function. To change the configuration specification (config spec) for the view, use the Rational
ClearCase Edit View Properties dialog box.

When changes have been made to the A pplication Developer workspace file system outside of Application
Developer (e.g., using an external text editor or using the ClearCase Merge Manager), Application Devel oper
does automatically synchronize with the Rational ClearCase VOB. When this occurs you must use the
Application Developer Refresh From Local function to cause changesto appear in Application Devel oper.

Working on a Project in the Integrated Environment

Asyouwork on aproject, you may wish to perform avariety of change management functions. This section
describes these functions. Asageneral rule, the recommended mode of operation isto do explicit checkin and
checkout of projects, directories and files.

Adding an Element to Source Control

Within the Application Devel oper environment, you may specify that new project objects or elements be placed
under the control of Rational ClearCase. To do this, right-click on the file and choose Clear Case > Add to
Source Control. The Add Element to Source Control dialog box appears and you can place the element under
Rational ClearCase control.

Checkout and Edit

Rational strongly recommends that you perform explicit checkouts of files on which you wish to work. Tosave
time and speed development, Rational ClearCase checkout functions can be performed right from the Navigator
window in the Application Developer workspace. To check out asingle or multiplefiles, select the filesand
choose the Rational ClearCase checkout function by right mouse clicking on the object to access the ClearCase
context menu, or by selecting the checkout icon on the ClearCase tool bar. The Rational ClearCase checkout
dialog box appears and the ClearCase check mark icon appears next to the checked out file in the Navigator
window. The developer can then edit the file as necessary.

12
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Save and Checkin

When editing is complete, savethefile. Inthe Navigator window, select the file that has just been saved and
choose the checkin option through the right mouse click context menu, on the ClearCase pull-downmenu, or on
the ClearCase toolbar. The checkin dialog box appears so that the selected file can be checked in. If you are
using UCM, you are also prompted to specify an activity and comments that detail the changes that have been
made in plain language. Thisinformation is helpful in gaining a quick understanding of how the code has
changed and in selecting files to perform future Rational ClearCase operations, such asDeliver Sream When
the operation is complete the Rational ClearCase checkout icon disappears from the filein the Navigator
window.

Closing Application Developer Before All Files are Checked In

When you are attempting to close Application Developer, Rational ClearCase bringsto your attention any files
that remain checked out. Rational ClearCase notesthosefilesthat are still checked out and prompts you to check
theminif desired. You may choose to leave them checked out so you can continue working on them next time
you start Application Developer.

Special Case of Editing Before Checkout

The Application Developer environment permits editing before checkout on read-only files. When you attempt
to savethisfile, Rational ClearCase detects that the file has not been checked out and automatically checksthe
file out and associates it with the current activity if UCM isbeing used. The standard Rational ClearCase
checkin processes can now proceed.

If UCM isbeing employed on the project, an Activity ID isreguired. Theactivity that was associated with the
filewhen it was automatically checked out is presented at checkin time. If necessary, you may use the Set
Activity ID function on the ClearCase toolbar to change the activity 1D before saving any unchecked outfiles
thus causing these checked out versions to be included in the changed activity ID.

Moving Files

When you use the Application Developer Move function, the files are copied to their new location and deleted in
the old location. When these files are under the control of Rational ClearCase, you must run a script that
automatically updates thefile locationsin the Rational ClearCase VOB. Thisautomatically reconcilesthe
Application Devel oper workspace with the Rational ClearCase VOB. If you do not perform this step after an
Application Developer Move operation, thefilesin their old locations will continue to reappear whenever aview
isrefreshed and the filesin their new locationswill not appear.

Asthe Move operation proceeds, the Add Files to Source Control dialog box will appear. Thisisbecause
Rational ClearCase seesthe new location as new elements. Cancel this operation because the script will
automatically handle this. The script is called ccmove.pl and it works on multiple filesthat are under Rational
ClearCase control, aswell asasingle target directory that is also under Rational ClearCase control. For more
information on executing the ccmove.pl script, refer to the online help. Note that an alternative to running this
script isto manually update the Rational ClearCase VOB by manually moving filesto their new locations.

Renaming Files

When you use the Rename function in the Application Devel oper workspace, the files are copied to their new
names. Thefilesin the old location are deleted. When these files are under the control of Rational ClearCase,
you must run ascript that automatically updates the file namesin the Rational ClearCase VOB to match thosein
the Application Developer workspace. If you do not perform this step after an Application Developer Rename
operation, the old file names will continue to reappear whenever aview is refreshed and the new files will not
appear.

As the Rename operation proceeds, the Add Files to Source Control dialog box will appear. Thisisbecause
Rational ClearCase viewsthe new file names as new elements. Cancel this operation because the script will
automatically handle this. The script is called ccmove.pl and it works on multiplefilesthat are under Rational
ClearCase control, aswell as asingletarget directory that is also under Rational ClearCase control. For more
information on executing the ccmove.pl script, refer to the online help. Asan alternative to running the script,
you can manually rename the filesin the Rational ClearCase VOB.

Using Rational ClearCase with the WebSphere Studio Application Devel oper Refactor Function

Refactor is an Application Developer function that enables changes to classes and methods to be automatically
reflected in all affected application components. Two cases are: changing a Javamethod, and changing a Java
class.

13
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When Refactor changes amethod, it al so updates all source code that refersto the method. When this occurs,
Rational ClearCase automatically checks out the affected files. The refactor change is made and thefile remains
checked out. Y ou must then manually observe the change and check thefilein.

When Refactor performs achange to a class name, thefileisrenamed. Thisisthe same process as renaming a
file—you must run the ccmove.pl script to automatically reconcile the Rational ClearCase VOB with the class
name changes in the Application Devel oper workspace. Dependent classes are handled in the manner described
above in method name changes, i.e., files are checked out when modified and must be manually checked in.

Deleting Files

Inasimilar way, deleting files from the Application Devel oper workspace has a similar impact on the Rational
ClearCase VOB. The deleted files disappear from the Application Developer workspace, but may reappear in
the Application Developer workspace when you refresh the view from the Rational ClearCase VOB. Toresolve
this, delete the files from the Application Devel oper workspace. Navigate to and check out the directory that
contains the deleted files, then run the cleartool rmname command. When the operation is complete, check the
directory in. Moreinformation on deleting files can be found in the online help.

Using Rational ClearCase with the WebSphere Studio Application Developer Compare/ReplaceHistory
Function

Application Developer has a Compare and Replace History operation, which isexposed in the Java | DE portion
of Application Developer, the project Navigator window, the Package browser and the Outliner. Thishistory
mechanism appliesto local changes performed in auser’ s workspace and enables you to go back to an earlier
edit. Thefunctionisinvoked when afileis saved; it does not apply to merging multiple branches of changes.

To perform this, right mouse click on an element in the Navigator, Outline or Package Browser windows and
select thisoption. A dialog box is displayed to select the needed edit of thefile. If thefile has not been checked
out, Rational ClearCase will automatically check it out before saving.

The Rational ClearCase History mechanism performs a different function—its history tracks the evolution of
versions of files created globally acrossthe project team. To view aRational ClearCase history, use the Rational
ClearCase Version Tree Browser or History Browser and merge tools to view version differences and merge
across multiplefile versions.

Unified Change Management Operations in the Integrated Environment

This section discusses the Rational ClearCase Deliver and Rebase functionsthat may be used on adevelopment
project that employs Unified Change Management or UCM.

Delivering A Development Stream

Deliver StreamisaRational ClearCase function that enables you to deliver and integrate al or specific change
setsto the integration stream once an activity has been completed. For example, if your task wasto create new
feature A, you may deliver a change set relating only to new feature A into the stream.

To do this, select the Clear Case > Deliver Streamfunction or the toolbar icon. A diaog box ispresented. Sdlect
the devel opment stream that you would like to deliver. Whenever you checked in aset of changesinto Rational
ClearCase, you specified the activities that you performed. Now, at integration time, you can choose which
activities you would like to deliver into the integration stream. For example, your changes may have
implemented new feature A, and now you can choose to deliver only changesrelating to new feature A. At your
option you can specify the stream that you would like to receive the changes. After delivery, Rationa ClearCase
enabl es you to examine the integration stream with the changes. When you are satisfied with the results of the
merge in the integration view, check in the code by choosing Complete on the Deliver Streamdialog box.

Asyou deliver astream, you will probably have two different instances of Application Developer open—one
workspace will have the private devel opment workspace which contains the complete changes, and the other will
have the integration workspace open. When you invoke the Deliver Streamfunction, youwill have modifiedthe
file system outside of Application Developer. In order to refresh theintegration workspace with the results of the
merge in the integration view, use the Refresh from Local Application Developer function.

Rebasing with Rational ClearCase in the | ntegrated Environment

Rebase Streamupdates your private Rational ClearCase development stream to include any changes made
between the last baseline you were using and the baseline that you choose to use at this point. The
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baselines exist on the integration stream. When you perform the Rebase Streamoperation, you are
effectively merging changes from the integration stream into your private development stream. This
operation merges changes in the new baseline with changes you may have made in your development
stream but have not yet delivered to the integration stream. To perform this operation, choose the

Clear Case > Rebase Streammenu option or click on the Rebase Streamicon on the ClearCase toolbar. The
Rebase Streamfunction will not affect versions of files that are associated with any activities that are already
underway but have not been delivered.

Y ou must use the Refresh From Local A pplication Devel oper function in order to see the specified baselinein
the Application Devel oper workspace associated with your development view.

Using the Rational ClearCase Build Function

The Rational ClearCase build option that is available with Application Developer is called omake. The omake
function offers some distinct advantages over other build utilities—it can detect dependencies, reuse derived
objectswherever possible, produce detailed build documentation and optimize build times. It also guaranteesthe
reproducibility of software versions. Choose the Clear Case > Build option or the Build iconfromthetoolbar to
begin the process of compiling your executable code according to the specifications in the makefile. The
ClearCase build option, icon and menu option are available only in Rational ClearCase, not Rational ClearCase
LT. Notethat the project makefile must bein the root project directory before you perform abuild operation. It
isrecommended that you place the makefile—which must be named < project_name>.mak—under source
control.

Accelerate Rational ClearCase Success with Rational Services

IBM Rational providesworld-wide servicesthat get you up and running quickly, improve self-sufficiency and
accelerate project implementation:

With Rational Developer Network®™ (RDN) at your fingertips, you gain a vast Web-based resource of
technical expertise for quickly building your software development skills. RDN is an online community of
experts, mentors and software professional s dedicated to sharing knowledge about software design,
development and lifecycle maintenance.

Rational University complements IBM's comprehensive suite of development tools by providing you
with aunique role- and team-based curriculum that combines a proven software devel opment process and
best practices with astructured professional education curriculum. Both classroom instruction and on-dte
training options are available. Y ou can take advantage of these Rational ClearCase courses. Rational
ClearCase Basics, Rational ClearCase Fundamentals, Applying Rational ClearCase Meta Data, Rational
ClearCase Administration, Rational ClearCase MultiSite Administration, Principles of Software
Configuration Management, Introduction to Rational ClearCase UCM, Basics of Rational ClearCase Unified
Change Management, Fundamental s of Rational ClearCase and Unified Change Management, and
Managing Software Projects with Rational ClearCase and Unified Change Management.

Rational Professional Services brings you qualified consultantswith years of experienceto help accelerate
any phase of your development project. In addition to consulting and mentoring, Rational Professional
Services offers customized services.

Rational Worldwide Technical Support ensures that your project keeps moving forward with the help you

need, when you need it. Our maintenance programs offer efficient problem resolution via phone, e-mail,
Web and fax, as well as up-to-date access to Rational’ s latest software releases.
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Glossary of Terms

Application Developer Workspace—the set of projects that the user can work on in that instance of Application
Developer

Branch or Code Branch—in aparallel development environment, a branch or code branch is a development
path. Y ou can see the evolution of branchesin a Rational ClearCase Version Tree which graphically depicts
different branches of code that have been created to enable parallel development over time. Branchesisolatethe
work of developers whose changes should not yet be shared and enable devel opers to continue working while
integration, build and test periods occur.

Rational Clear Case View—provides access to exact versions of filesin the Rational ClearCase Versioned
Object Base (VOB); servesto shield the devel oper from the complexity of thelarger project environment while
completing a specific task. Snapshot views are availablein Rational ClearCase and Rational ClearCaseLT;
Dynamic views are available in Rational ClearCase.

Rational Clear Case Explor er—interface that provides accessto awide range of Rational ClearCase functions.
The Rational ClearCase Explorer isaccessible from within the Application Developer user interface.

Diff/merge—A Rational ClearCase function, this patented technology allowsyou to visually compare two or
more file versions, and merge them into asinglefile. Diff/mergeisacritical function for enabling parallel
development.

Plug-in—software that enables IBM or athird party tool to plug into WebSphere Studio Workbench. The
benefit isthe ability to assembl e disparate toolsinto a common development environment that precisely meets
devel opment needs for complex e-business applications.

Refactor —an Application Devel oper function that enables automatic updates to dependent dassesand methods
across all affected application components. Refactor may involve moving or renaming classes and methods and
this has source control implications.

Versioned Object Base (VOB)—a Versioned Object Base or VOB isthe term used to describe the Rational
ClearCase source control storage repository.

IBM WebSphere Studio Workbench—new IBM devel opment tools platform. Through plug-ins, IBM and
other tools vendors can participate in an open, simple, extensible development environment. While not a
purchasabl e product, common Workbench functions are seamlessly available in tools such as Application
Developer.

16



Rational ClearCase Integration With IBM WebSphere Studio Application Developer

Resources

Rational ClearCase
Product infor mation: www.rational .com/products/clearcase/index.jsp

Technical Support Information Page: www.rational.com/support/products/clearcase.jsp

Rational Clear Quest
Product information: www.rational.com/products/clearquest/index.jsp

Technical Support Information Page: www.rational.com/support/products/clearquest.jsp

Rational Technical Suppor t

Phone: 800-433-5444

E-mail: support@rational.com

Internet support request form: www.rational.com/support/forms/supportrequest-new.jsp

IBM WebSphere Studio Application Developer :
www-3.ibm.com/software/ad/studioappdev/
www7b.boulder.ibm.com/wsdd/library/techarticles/0108_studio/studio_beta.html

IBM WebSphere Studio Workbench:
www-3.ibm.com/software/ad/workbench
www.devel oper.ibm.com/wel come/wstool sworkbench.html

IBM WebSphere Softwar e Platform Main Page:
www-4.ibm.com/software and click WebSpher e button
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IBM software integrated solutions
IBM Rational supports a wealth of other offerings from IBM software. IBM
software solutions can give you the power to achieve your priority business

and IT goals.

« DB2® software helps you leverage information with solutions for data
enablement, data management, and data distribution.

+ Lotus® software helps your staff be productive with solutions for
authoring, managing, communicating, and sharing knowledge.

+ Tiwoli® software helps you manage the technology that runs your e-
business infrastructure.

. WebSphere® software helps you extend your existing business-critical
processes to the Web.

* Rational® software helps you improve your software development
capability with tools, services, and best practices.

Rational software from IBM

Rational software from IBM helps organizations create business value by
improving their software development capability. The Rational software
development platform integrates software engineering best practices, tools,
and services. With it, organizations thrive in an on demand world by being
more responsive, resilient, and focused. Rational's standards-based, cross-
platform solution helps software development teams create and extend
business applications, embedded systems and software products. Ninety-
eight of the Fortune 100 rely on Rational tools to build better software,
faster. Additional information is available at www.rational.com and
www.therationaledge.com, the monthly e-zine for the Rational community.
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